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revealing and understanding complex interactions between stem cells and their

microenvironment. Here, we present a gentle but fast whole-mount immunofluorescence

staining protocol for 3D confocal microscopy (iFAST3D) that preserves the 3D structure of the

entire tissue and that of subcellular structures with high fidelity. The iFAST3D protocol enables

reproducible and high-resolution 3D imaging of stem cells and various niche components for

many mouse organs and tissues.
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SUMMARY

Quantitative 3D imaging of organ-wide cellular and subcellular components is
central for revealing and understanding complex interactions between stem cells
and their microenvironment. Here, we present a gentle but fast whole-mount
immunofluorescence staining protocol for 3D confocal microscopy (iFAST3D)
that preserves the 3D structure of the entire tissue and that of subcellular struc-
tures with high fidelity. The iFAST3D protocol enables reproducible and high-res-
olution 3D imaging of stem cells and various niche components for many mouse
organs and tissues.
For complete details on the use and execution of this protocol, please refer to
Saçma et al. (2019).

BEFORE YOU BEGIN

To investigate the position of cells within a 3D space in a tissue for understanding complex cellular

networks, like stem cell and stem cell niche interactions, sophisticated quantitative imaging tools are

already available (Acar et al., 2015; Nombela-Arrieta et al., 2013; Coutu et al., 2018; Fra-Bido et al.,

2021; Kunisaki et al., 2013; Kusumbe et al., 2014). One large drawback of these protocols is that they

are technically very challenging, time consuming and often also require the use of very special

equipment and tools. These restrictions might currently be in the way of a more widespread appli-

cation of 3D in situ or in vivo imaging. We present here a fast while gentle methodology termed

iFAST3D that enables high-fidelity 3D analysis of stem cells, endothelial and stromal structures

and the determination of their spatial co-distribution directly in situ. iFAST3D is a straightforward

protocol for 3D visualization of distinct types of cells and microstructures within a highly intact tissue

architecture up to 75 mm depth and able to deliver final results already after 2 days (Figures 10–12).
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The protocol below describes the specific steps for simultaneously staining of hematopoietic stem

cells (HSCs) and niche components (vasculature, megakaryocytes, endosteum) using difficult to im-

age bone (femur) and bone marrow (BM) that was initially developed in the key supporting paper

(Saçma et al., 2019; Landspersky et al., 2021). With a few technical modifications (variation of anti-

body concentrations and incubation times), the protocol can be extended to other types of murine

tissues and organs without changing the sample preparation methodology.

Before the staining procedure, you need to prepare the solutions (see ‘‘materials and equipment’’ for

detailed recipe):

Fixation solution 4% PFA for the perfusion and fixation approximately 50 mL per mouse.

Washing buffer solution for washing steps and tissue covering during confocal microscopy.

Antibody diluent buffer for blocking and incubation steps.

Institutional permissions

All mouse experiments were performed in compliance with the ethical regulations according to the

German Law for Welfare of Laboratory Animals and were approved by the Institutional Review Board

of the local institutions, as well as by the state government of Baden-Württemberg (Protocol Num-

ber: 35/9185.81-3 / 1363). Researchers should check or obtain permissions from the relevant local

institutions before undertaking this protocol.

Preparation of bones with intravital vasculature pre-staining

Timing: 1 h

1. Intravital vasculature staining.

a. Weigh the mouse to calculate the volume of antibodies: APC-anti-CD31 0,8 mL/g and Alexa

Fluor� 647-anti-CD144 0,32 mL/g.

b. Dilute antibodies in PBS for a total of 200 mL.

c. Inject the antibody solution intravenously into the lateral tail vein (troubleshooting 1).

d. Leave the mouse at 18�C–25�C for 20 min.

2. Perfusion of the mouse.

a. Anesthetize the mouse deeply: anesthesia is induced by intraperitoneal injection of a

mixture of ketamine (100 mg/kg) and xylazine (16 mg/kg). Once sufficient depth of anes-

thesia is achieved and ensured (checked by inter-toe and tail tip, eyelid and corneal re-

flexes), administer repeated doses (100 mL) of anesthesia to provide deep surgical-plane

anesthesia.

b. Perfusion surgery (troubleshooting 1 and 2).

i. Grip the skin with forceps under the chest and make a lateral and two incisions towards

the collarbones with fine scissors and open the skin. (Figure 1A).

ii. Grip the xiphisternum, make lateral incisions through the abdominal wall and carefully

open the diaphragm along the rib cage with fine scissors. Subsequently, make two lateral

cuts along both sides of the rib cage up to the clavicles and lift the sternum with the trun-

cated ribs and clamp them with a hemostat to expose the chest cavity including the heart

(Figure 1B).

iii. Insert a 23-G needle or a 23-G butterfly needle through the posterior end of the left

ventricle (LV) 0.3–0.5 cm deep. An incision is then made in the animal’s right atrium

(RA) to create the largest possible outlet without damaging the aorta (Figures 1C

and 1D).
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Note: Clamping with a hemostat can help to secure the needle from slipping and leakage

(Figure 1C).

iv. Perfuse the animal at a slow and steady rate (�1 mL/5 s): first with ice-cold PBS (�30 mL)

followed by ice-cold 4% PFA fixation solution (�30 mL) using a 30 mL syringe (Figure 1C).

Note: Twitching, fading liver, head and tail movement and stiffness are signs of successful

perfusion.

CRITICAL: Work in a hood (PFA is harmful).

Collection and fixation of bones

Timing: 24 h

3. Bone isolation.

a. Isolate required bones (femora, tibiae, sternum, humeri).

b. Clean bones accurately from muscles and ligaments well (Figure 2) with fine scissors and low-

lint wipes, completely dip in PBS and place in 15 mL 4% PFA fixation solution in a 15 mL centri-

fuge tube on ice (troubleshooting 2).

4. Fixation of bones in 15 mL 4% PFA fixation solution in 15 mL centrifuge tube for 24 h at 4�C (trou-

bleshooting 1 and 2).

Note: We achieved similar staining results for min. 20 h to max. 30 h of fixation at 4�C for

bones. We recommend 16 h fixation time for thymus, 24 h for muscle and spleen and 30 h

for brain in 15 mL 4% PFA fixation solution in 15 mL centrifuge tubes at 4�C.

Figure 1. Perfusion surgery steps

(A) Direction and position of skin incisions.

(B) Exposed thoracic cavity.

(C) Transcardiac perfusion view.

(D) Direction and position of the needle insertion into the left ventricle (LV) and incision site on the right atrium (RA).

Figure 2. Isolated and cleaned long bones

Isolated and cleaned (A) femur, (B) tibia and (C) humerus.
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KEY RESOURCES TABLE

REAGENT or RESOURCE SOURCE IDENTIFIER

Antibodies

anti-B220 (clone RA3-6B2) (1:100) Thermo Fisher Scientific Cat# 13-0452-85; RRID: AB_466450

anti-CD11b (clone M1/70) (1:100) Thermo Fisher Scientific Cat# 13-0112-85; RRID: AB_466360

anti-CD8a (Clone 53-6.7) (1:100) Thermo Fisher Scientific Cat# 13-0081-85; RRID: AB_466347

anti-Gr-1 (clone RB6-8C5) (1:100) Thermo Fisher Scientific Cat# 13-5931-85; RRID: AB_466801

anti-Ter119 (1:100) Thermo Fisher Scientific Cat# 13-5921-85; RRID: AB_466798

PE anti-CD150 (clone TC15-12F12.2) (4 mg/mL), critical
reagent

BioLegend Cat# 115904; RRID: AB_313683

anti-CD41 (clone MWReg30) (1:2500) Thermo Fisher Scientific Cat# 13-0411-85; RRID: AB_763489

anti-CD48 (clone HM48-1) (1:100) Thermo Fisher Scientific Cat# 13-0481-82; RRID: AB_466470

APC anti- CD31 (clone MEC13.3) (0,8 mL/g) BioLegend Cat# 102510; RRID: AB_312917

Alexa Fluor� 647 anti-CD144 (clone BV13) (0,32 mL/g) BioLegend Cat# 138006; RRID: AB_10569114

Streptavidin-eFluor�450 (1:60) Thermo Fisher Scientific Cat# 48-4317-82; RRID: AB_10359737

FITC anti-Ki-67 (clone SolA15) (1:100) Thermo Fisher Scientific Cat# 11-5698-82; RRID: AB_11151330

anti-FABP4/A-FABP (1:100) R&D Systems Cat# AF1443; RRID: AB_2102444

anti-goat Alexa Fluor� 647-conjugated (1:100) Jackson ImmunoResearch Cat# 705-605-003; RRID: AB_2340436

anti-LepR (1:100) R&D Systems Cat# AF497; RID: AB_2281270

anti-goat Cy3-conjugated (1:100) Jackson ImmunoResearch Cat# 705-165-003; RRID: AB_2340411

anti-H4K16ac (1:200) Millipore Cat# 07-329; RRID: AB_310525

anti-rabbit Alexa Fluor� 488-conjugated (1:200) Jackson ImmunoResearch Cat# 711-545-152; RRID: AB_2313584

PE anti-Ki-67 (clone SolA15) (1:100) Thermo Fisher Scientific Cat# 12-5698-80; RRID: AB_11149672

Streptavidin-PE (1:60) Thermo Fisher Scientific Cat# 12-4317-87

Streptavidin-APC (1:60) Thermo Fisher Scientific Cat# 17-4317-82

Chemicals, peptides, and recombinant proteins

DAPI Sigma-Aldrich Cat# D9542-1MG

Donkey normal serum Jackson ImmunoResearch Cat# 017-000-121; RRID: AB_2337258

Goat normal serum Dako Cat# X090710-8

DPBS, Dulbecco’s PBS without Ca2+ Mg2+ PAN-Biotech Cat# P04-36500

Formaldehyde solution ROTIPURAN� 37% Carl Roth Cat# 4979.1

Ketanest S 25 mg/mL Pfizer Cat# 37087.00.00

Penicillin/Streptomycin, P/S PAN-Biotech Cat# P06-07100

Xylazine, Rompun 2% Bayer Animal Health Cat# 14840

Triton� X-100 Sigma-Aldrich Cat# T9284-100ml

Experimental models: Organisms/strains

Mouse C57BL/6J, 2–26 months old, either gender Janvier Labs, internal divisional stock Cat# C57BL/6JRj

Mouse Nestin-GFP, 8–16 weeks old, either gender Jackson Laboratory, internal divisional stock Cat# 033927

Mouse Rag2�/�gc�/�KitW/W, 8–16 weeks old, either
gender

internal divisional stock N/A

Mice AcRFP, AcYFP, AcCFP, 2–26 months old, either
gender

internal divisional stock N/A

Mouse SCL-tTAxH2B-GFP, 8–16 weeks old, either
gender

DKFZ Heidelberg N/A

Software and algorithms

Volocity Quorum Technologies,
PerkinElmer

www.volocity4d.com; www.perkinelmer.com

ImageJ National Institutes of Health https://imagej.nih.gov/ij/

LAS-X acquisition software Leica LAS-X-3.1.5.16308

Zen acquisition software Zeiss Zen-2.3-SP1

Other

Leica TCS SP8 confocal microscope Leica SP8

Zeiss LSM-710 confocal microscope Zeiss LSM-710

Objective HC-PL-APO-CS2 203/0.75 Leica Cat# 11506343

(Continued on next page)
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MATERIALS AND EQUIPMENT

Note: 4% PFA fixation solution need to be prepared weekly and can be stored at +4�C.

CRITICAL: Paraformaldehyde is a flammable solid and is harmful if swallowed or inhaled,

may causes skin irritation, skin allergic, serious eye damage, respiratory irritation, even ge-

netic defects and cancer. Follow all safety guidelines.

Note: The washing buffer solution can be stored at 4�C up to several weeks.

Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Objective HC-PL-FLUOTAR 103/0.30 Leica Cat# 11506505

Objective Plan-APO 203/0.8 M27 Zeiss Cat# 420651-9911000

Objective Plan-APO 103 0.3 M27 Zeiss Cat# 420640-9800000

Cryostat CryoStar NX70 Thermo Scientific Cat# 957000

Microtome blade A35 Feather Cat# 207500011

4-well-m-slide with glass bottom ibidi Cat# 80427

24-well culture plates, suspension Sarstedt Cat# 83.3922

OCT, Embedding medium Tissue-Tek� O.C.T. Sakura Cat# 4583

Cryomold Tissue-Tek� Cryomold� (25 3 20 3 5 mm) Sakura Cat# 4557

Wipes, low-lint Kimberly-Clark Cat# 7552

15 mL centrifuge tube, 120 3 17 mm Sarstedt Cat# 62.554.002

Fine scissors Fine Science Tools Cat# 14058-11

Hemostat Fine Science Tools Cat# 13008-12

Forceps Fine Science Tools Cat# 11008-13

Long-armed tweezers Carl Roth Cat# 0951.1

23-G needle Henke-Sass, Wolf Cat# 4710006025

30 mL syringe B. Braun Cat# 4616308F

23-G butterfly needle B. Braun Cat# 4056353

4% PFA fixation solution

Reagent Final concentration Amount

37% Formaldehyde 37% 60.61 mL

DPBS n/a 500 mL

NaOH 1 M n/a adjust pH=7.4, �1080 mL

HCl 1 M n/a adjust pH=7.4

Total 4% n/a

Washing and storage buffer solution

Reagent Final concentration Amount

DPBS 13 495 mL

Penicillin/Streptomycin P/S 1% 5 mL

Total n/a 500 mL

Antibody diluent buffer

Reagent Final concentration Amount

Washing buffer solution n/a 49.75 mL

Triton� X-100 0.5% 0.25 mL

Total n/a 50 mL
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Note: The antibody diluent buffer solution can be stored at 4�C up to several weeks.

CRITICAL: Triton� X-100 is harmful if swallowed and causes skin irritation and serious eye

damage. It is very toxic to aquatic life with long lasting effects. Follow all safety guidelines.

Note: *if a used antibody is raised from goat (host species), we use normal donkey serum to

prevent unspecific binding. The blocking and permeabilization solution can be stored at 4�C
for up to 2 days.

Cryostat settings: The temperature of the specimen’s head and the blade should be adjusted to the

manufacturer’s manual and the tissues. For bones, we recommend the specimen holder between

�18�C to �22�C and for the blade between �15�C to �19�C. Set the trimming thickness to

40 mm and the fine section thickness to 5 mm. The recommended cutting angle is 10�.

Alternatives: Theoretically, the reagents and operating materials listed in the key resources

can be replaced by equivalent items from other vendors. However, the impact of alternative

reagents on performance has not been tested.

Microscope settings: Acquisition software of the Leica-SP8 was LAS-X-3.1.5.16308 and the used ob-

jectives were HC-PL-APO-CS2 203/0.75 and HC-PL-FLUOTAR 103/0.30. The detectors were 3 pho-

tomultiplier (PMT) and two internal hybrid detectors (HyDs). The acquisition software of the

ZeissLSM-710 was Zen-2.3-SP1 and the used objectives were Plan-APO 103 0.3 and 203/0.8

M27. The detectors were 4 PMTs. The laser sources were 405-Diode, Argon, DPSS-561 and

HeNe-633 with the laser lines 405 nm, 458 nm, 476 nm, 488 nm, 496 nm, 514 nm, 561 nm or 633 nm.

STEP-BY-STEP METHOD DETAILS

Tissue cryoprotection

Timing: 30 min–2 h

In this step, embedding in water-soluble embedding medium and snap freezing in liquid nitrogen

for tissue preservation is described.

1. Embedding in optimal cutting temperature compound (OCT).

a. Rinse the bones 23 with 10 mL PBS in 15 mL tubes to get rid of PFA solution.

b. Dry the bones with tissue; make sure that they are clean; if necessary, remove redundant tis-

sue.

c. Fill the cryomolds with OCT until the upper limit.

d. Positioning of the tissue in OCT (Figure 3).

i. Place the bones longitudinally close to the left side of the OCT containing cryomold.

ii. Make sure the bones are fully immersed and parallel to the left edge of the cryomold (Fig-

ure 3), to achieve the maximal frontal tissue surface after cryo-shaving.

iii. Move bubbles out if they are formed.

Blocking and permeabilization solution

Reagent Final concentration Amount

Antibody diluent buffer n/a 0.8 volume

Normal goat serum or donkey serum* 20% 0.2 volume

Total n/a 1 volume
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2. Snap freezing in liquid nitrogen (LN2).

a. For dealing with LN2, wear protective equipment in appropriate rooms.

b. Grab the filled cryomold with long-armed tweezers with the help of a table surface (Figures 4A

and 4B).

c. Touch gently with the bottom of the cryomold the surface of the LN2 in an appropriate open

LN2 Dewar flask. Attachment is ensured when a bubbling sound begins (Figure 4C).

CRITICAL: Too quick plunging of the sample into LN2 can cause formation of bubbles.

d. Let the OCT get freeze (white) from bottom to top (Figure 4D).

e. When the OCT is totally frozen (Figure 4E, drop it into the LN2 (Figure 4F).

CRITICAL: Fast snap freezing is essential to prevent formation of ice crystals which induce

cellular and architectural tissue damage.

CRITICAL: For long-term preservation (up to 5 years, see Figure 14) frozen and embedded

tissue should be stored subsequently at �80�C.

Cryostat shaving procedure

Timing: 20 min/tissue block

This section describes the cryostat shaving procedure of the specimen for obtaining optimal bi-

sected bone whole-mounts for 3D confocal imaging.

3. Set up the cryostat settings according to the ‘‘materials and equipment’’ section.

4. Transfer the samples to dry ice to prevent OCT melting.

5. Freeze the frozen block on a specimen chuck on the long side using OCT and with the tissue up-

side down. If available, use a quick freeze chamber.

CRITICAL: The chuck should be at 18�C–25�C prior to use to ensure optimal adhesion.

6. Allow time (5–10 min) for the temperatures within the cryostat to stabilize.

7. Start to shave the block with the trimming function until the bone marrow is maximally exposed.

Also see Methods video S1.

CRITICAL: To prevent severe damage, ensure that the blade does not crash into the

sample.

Figure 3. Embedding position of long bones

Embedding position of (A) femur, (B) tibia and (C) humerus in OCT.
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8. Switch to the sectioning thickness and shave the specimen 10–203. Also see Methods video S1.

CRITICAL: To ensure a planar shaved surface, check during the shaving steps the blade for

notches caused by the bone matrix. If notches occur, shift the blade to an undamaged part

or use a new one (troubleshooting 2). Be cautious during the shaving procedure as the

blades are very sharp.

Note: Use a brush to remove debris from the sample.

9. Cut the frozen tissue block with a razor blade from the specimen chuck.

10. The shaved samples can be stored 3–4 weeks at �80�C prior to immunofluorescence staining.

Whole-mount immunostaining

Timing: 1–7 days

This section describes the immunostaining procedure to image 3D information of hematopoietic

stem cells and niche components (vasculature, endosteum, megakaryocytes) throughout the whole

femoral bonemarrow section with optimized antibodies, which, in total, need 5 days. The incubation

times and concentrations of the used antibodies in this protocol are the same for other appropriate

tissues. Novel antibodies should be validated before use.

11. Purification from melting OCT.

a. Place the shaved and frozen samples into a box with separating chambers which are filled

with �150 mL cold (4�C) washing buffer solution to cover the samples (Figures 5A and 5B).

CRITICAL: Throughout the remaining parts of the protocol, avoid touching the exposed

bone marrow to prevent losing cells and causing tissue artifacts (troubleshooting 2).

Figure 4. Snap freezing in liquid nitrogen

(A) Grabbing the filled cryomold with long-armed tweezers.

(B) Side view of the cryomold with a table surface.

(C) Touching the bottom of the cryomold with the surface of the LN2.

(D) Freezing of the OCT (white) from bottom to top.

(E) Totally frozen OCT.

(F) Dropping the specimen into LN2.
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b. Wait until the OCT around the sample is melted in the cold (4�C) washing buffer solution (Fig-

ure 5C).

c. After the OCT is melted (Figure 5C), take out the exposed samples cautiously with tweezers

and wash the bones with washing buffer solution with a plastic bottle to get rid of sticky OCT

(Figure 5D).

CRITICAL: Don’t pour the washing solution directly to the exposed bone marrow to avoid

causing artifacts.

Note: Use a see-saw rocker with ca. 30 rpm and cover the samples with a box from light for

every step from now on.

12. Prepare 24-well plates (wp) for fixation and washing (Figure 6A) and 0.2 mL PCR tubes for block-

ing and antibody incubation (Figure 6B).

Note: Solution amounts in 0.2 mL PCR tubes for blocking and antibody incubation for femur is

260 mL, for tibia 250 mL, for humerus and sternum 200 mL. In general, the processed tissue

should be fully covered by the solution in the tube.

13. Fixation in 24-wp.

a. Fill one well for each sample with 2 mL 4% PFA fixation solution.

b. Place the bone samples into the fixation solution with the shaved surface, so that the BM

doesn’t touch the bottom and incubate for 30 min at 18�C–25�C.
14. Wash the samples 33 20 min at 18�C–25�C by relocating from well to well with each well con-

taining 2 mL of washing buffer solution.

15. Place the samples in 0.2 mL PCR tubes with blocking and permeabilization buffer; incubate at

18�C–25�C for 1 h.

16. Primary hematopoietic lineage antibody staining (troubleshooting 3 and 4):

a. Prepare the lineage antibody cocktail solution with biotinylated anti-CD41 (1:2500), anti-

CD48 (1:100), anti-CD11b (1:100), anti-B220 (1:100), anti-CD5 (1:100), anti-Gr-1 (1:100),

anti-Ter119 (1:100), anti-CD8a (1:100) in antibody diluent buffer.

b. Incubate at 4�C for 2 days.

Figure 5. Purification from melting OCT

(A and B) Frozen samples in PBS.

(C) Melting samples.

(D) Washing samples with washing buffer solution.
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CRITICAL: Spin down the antibody vials to remove aggregates and precipitates to avoid

the occurrence of non-specific fluorescent spots.

17. Wash the samples 33 20 min at 18�C–25�C in washing buffer solution (troubleshooting 4).

18. Secondary antibody staining (troubleshooting 3 and 4):

a. Prepare secondary antibody solution with streptavidin (eFluor�450- or FITC- conjugated,

1:60) in antibody diluent buffer.

b. Incubate at 18�C–25�C for 2 h.

19. Wash the samples 33 20 min at 18�C–25�C in washing buffer solution (troubleshooting 4).

20. SLAM antibody staining (troubleshooting 3 and 4):

a. Prepare antibody solution with anti-CD150-PE (4 mg/mL) in antibody diluent buffer.

b. Incubate at 4�C for 3 days.

21. Wash the samples 33 20 min at 18�C–25�C in washing buffer solution.

22. Place the bone samples in 24-wp in storage buffer solution (2 mL per well) with the shaved sur-

face and store at 4�C in the dark until microscopy.

Pause point: Samples can be imaged 1–3 days after the staining procedure.

Confocal microscopy

Timing: 0.5 days

This section describes the sample mounting and confocal 3D microscopy. Every immunostaining

experiment has special settings and here we give the basic settings for 3D imaging we are using

for the iFAST3D protocol.

Note:With many confocal microscope acquisition software you can retrieve settings from pre-

vious experiments.

23. Drop 30 mL–80 mL washing and storage buffer solution to the bottom glass of a 4-well-m-slide

(Figure 7A) to prevent tissue desiccation.

24. Place the fluorescently labeled tissue cut-face down onto the drop in the 4-well-m-slide

(Figures 7B and 7C) and check from the bottom side that the sample surface is completely

touching the glass planar (Figure 7D).

CRITICAL: Avoid too much pressure which can press out BM and prevent formation of air

bubbles (troubleshooting 2 and 5).

25. Cover the microscope glass chamber with the associated lid.

Figure 6. Washing and incubation equipment

(A) 24-wp for fixation and washing.

(B) 0.2 mL PCR tubes for blocking and antibody incubation.
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26. Switch on the confocal microscope system.

27. Place the glass chamber on the stage of the microscope.

28. Use a 103 objective for preview and choose a region for setting up in the widefield mode.

29. Set up the acquisition settings for confocal microscopy:

a. Set up the channel configurations based on the excision/emission parameters of the used

fluorochromes and dyes in the staining.

Note: If available, use the auto-set-up mode with the ideal option.

b. Use transmitted light detection (DIC) for trabecular and cortical bone matrix detection and

for structural details.

c. Use an image size resolution of 10243 1024 with bidirectional scanning (600 Hz–800 Hz) and

3–53 averaging.

30. Switch to a 203 objective and confocal live mode.

31. Optimize the detector parameters gain, laser power etc. by negative controls and/or by a soft-

ware over-saturation option (troubleshooting 3 and 4).

CRITICAL: Avoid long-lasting laser exposure of the region of interest (ROI) to prevent pho-

tobleaching of sensitive types of labeled antibodies.

32. Scan for a ROI using 103 objective in the widefield mode.

33. Switch back to a 203 objective and confocal live mode.

34. Set up the z-stack configurations:

a. Set up the lower and upper focal plane scanning limits. A limit is reached when the image is

out of focus. Z-thickness size can vary between 20 mm–75 mm.

b. For optimal and fast scanning, use a step size between 1.0 mm to 3.5 mm (z-step size).

Optional: Set start and stop points for z-stack tile scanning.

35. Start the scanning procedure for 3D imaging and save your z-stack data subsequently.

Figure 7. Microscope glass chamber

(A) 4-well-m-slide chamber with 60 mL washing and storage buffer solution.

(B and C) Placing of a whole-mounted sternum.

(D) View from the bottom side of the sample.
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Processing and 3D visualization of raw data using Volocity analysis software

Timing: 30 min per image

This section describes how to import raw data, how to process images to visualize in 3D and how to

export images by using Volocity software as an example. For 3D reconstruction and subsequent

quantification and analysis of structural, cellular, and subcellular properties, also other image anal-

ysis platforms (e.g., Imaris, ImageJ, FIJI) can be used.

Note: Common file formats with metadata, generated by conventional confocal microscope

systems, are supported and can be added to Volocity by drag and drop. The software saves

every step automatically.

36. Import of raw images:

a. Go to the ‘‘File’’ menu and select ‘‘New Library.’’ (Figure 8A).

b. Name the library and choose the destination for storage.

c. Drag the raw image, or folder with images, into the ‘‘Library’’ view on the left side of the

screen (Figure 8B).

d. Image sequences with the appropriate XYZ dimensions, channels and timepoints will be

generated automatically.

e. Imported images can be viewed in different modes, like ‘‘3DOpacity’’, ‘‘XYZ’’ and ‘‘Extended

Focus’’ (Figure 8C).

Note:We use the ‘‘Extended Focus’’ mode for fast screening of the images and enhancement

of the signal intensity and brightness for individual channels.

37. 3D visualization:

a. Select the image from the ‘‘Library’’ view for 3D visualization.

b. In the drop-down menu at the top of the screen, change the display option to ‘‘3D Opacity’’

(Figure 9A).

Figure 8. Key steps for importing and loading raw images in Volocity

(A) ‘‘New Library.’’ selection in the ‘‘File’’ menu.

(B) ‘‘Library’’ view section.

(C) Image view modes.
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c. Use the tools at the top of the window to change actions for rotating and zooming for a

required 3D view (Figure 9B).

d. Optimize the brightness (recommended 13–43), density (recommended 50%) and the black

level (recommended 2%–10%) for individual channels on the channel control view on the

right side of the screen (Figure 9C).

e. Choose from the channel control view the proper rendering ‘‘Mode’’ (Fluorescence, Isosur-

face, Max Intensity) for the best presentation of your data and observations (Figure 9D).

f. To show a scale bar and the XYZ-orientation on the image, go to the ‘‘Image’’ menu, the

‘‘Display’’ menu and select ‘‘Show Scale’’ and ‘‘Show Orientation’’ (Figure 9E).

38. Export of 3D visualized images:

a. To create a single image illustration of the current 3D view, go to the ‘‘Image’’ menu and

select ‘‘Capture Snapshot.’’ (Figure 9F).

b. A snapshot image is added at the bottom of the library list.

c. Select the snapshot image from the library list and in the ‘‘File’’ menu choose ‘‘Export.’’.

d. The snapshot of the 3D visualization can now be exported in any supported file format (e.g.,

TIFF, BMP, JPEG).

EXPECTED OUTCOMES

The protocol for iFAST3D is straightforward, fast and gentle to allow for subsequent confocal whole-

mount immunofluorescence staining and analysis. This enables comprehensive 3D analyses of

different mouse organs and tissues from large field down to subcellular levels at high resolution

and quantitative analysis of in situ 3D stem cell and niche component distribution. In the bone sam-

ples typically, you can see HSCs (CD150+CD41�CD48�LIN�, marked by yellow dots), non-HSC

Figure 9. Key steps for processing and 3D visualization and exporting images in Volocity

(A) Display option ‘‘3D Opacity’’.

(B) Tools for change actions.

(C) Channel control slider.

(D) Rendering mode selection.

(E) ‘‘Image’’ menu with the ‘‘Display’’ submenu.

(F) ‘‘Capture Snapshot.’’ selection.
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hematopoietic cells (white, CD150�CD41+CD48+LIN+), big-shaped megakaryocytes (big red cells,

CD150+CD41+), endothelial cells forming the BM vascular network (blue) and bone (gray) (Methods

video S2).

iFAST3D requires minimal histology equipment for sample collection and staining and only conven-

tional confocal microscopy for deep imaging up to 75 mm (Figure 10).

The protocol minimizes the use of chemical solvents, incubation time and mechanical stress to pre-

serve tissue morphology, and as well as molecular integrity. Thus, there is no necessity for frequently

artifact-causing and time-consuming processes of decalcification, clearing, dehydration or

sectioning.

The pipeline allows very fast high resolution 3D analysis of tissue and endothelial and stromal struc-

tures and the determination of spatial distribution of a large number of single cells and structures

and their interrelationships directly in situ within 2 days already (Figure 11).

The protocol is extremely versatile and can be applied to different tissues and organs without chang-

ing the sample preparation methodology. Moreover, the staining can be customized without

altering critical steps in the protocol for 3D visualization of distinct types of cells and microstructures

within a highly intact tissue architecture (Figures 11 and 12).

Preservation of fluorescent proteins (including GFP, YFP, CFP and RFP) facilitates the use of novel

and versatile combinations and multiplexing of various dyes (Figures 12 and 13).

Fixed and pre-stained organs can be stored long-term at �80�C (at least up to five years) for subse-

quent imaging by iFAST3D (Figure 14).

LIMITATIONS

Samples should be imaged 1–3 days after the staining procedure, due to the low stability of some

fluorescently-labeled antibodies. There is the possibility for fast photobleaching of some types of

primary labeled antibodies (e.g., CD150-PE) by confocal laser exposure. This restricts for some sam-

ples the adjustment of scanning or repeated scanning. The protocol is not working well for immuno-

histochemistry staining protocols. The protocol only offers a static view of the tissue and does not

allow for direct intravital imaging.

Figure 10. iFAST3D imaging depth for 3D information

Representative 3D reconstruction of confocal images of epiphysis/metaphysis with schematic longitudinal surface of

a bisected bone and BM and affiliated xy-, xz- and yz-projections. Vasculature (red) and nuclei (in blue, DAPI).
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TROUBLESHOOTING

Problem 1

Vasculature (intravital) staining issues. Confocal microscopy.

Figure 11. iFAST3D enables FAST and high-fidelity 3D confocal IF imaging

(A) Whole-mount confocal image of label retaining (LR) mouse BM vasculature (magenta) and Leptin Receptor+

(LepR+) cells (red) with LR-cells (GFP+, green) after only 3 days of workflow. Vasculature was stained intravenously with

anti-PECAM1 (CD31) and anti-VE-Cadherin (CD144) antibodies.

(B) Representative stacked whole-mount and 3D reconstructed confocal images of myofibrils from Gluteus Maximus

showing the muscle microvasculature and the localization of GFP+ satellite cells (Nestin-GFP, Day et al., 2007).

(C) Dentate Gyrus in Hippocampus, brain microvasculature, neuronal stem cells in the SGZ (1) and perivascular cells (2)

in the ML (Nestin-GFP, Mignone et al., 2004) (SGZ = Subgranular zone; ML = Molecular layer, GCL = Granule cell

layer).
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Figure 12. iFAST3D enables multicolor IF for mouse organs and tissues

(A) Extended focus projection images revealing the microvasculature (red) of the thymus in the cortex and medulla

with different locally concentrated thymocytes (CD5/CD8a magenta) in longitudinal whole-mounts from Nes-GFP

mouse thymus, which imply a special role for Nes-GFP+ perivascular cell ensheathed microvessels in the cortex of the

thymus.

(B) Longitudinal spleen whole-mounts from Nes-GFP mice. Extended focus projections depicting the splenic capsule,

the marginal zone, the B cell corona with frequent B cells (B220, magenta), the microvasculature (red) with arterioles

(indicated by periarteriolar Nes-GFPhigh cells) located frequently in the white pulp region and venous vasculature (red)

concentrated in the red pulp zone.

(C) Z-stacked whole-mount image (overview) and 3D reconstructions (image 1 and 2) of a mesenteric lymph node from

Nes-GFP mouse, showing the marginal and medullary sinus (MaS andMeS), the follicles (LF), the germinal center (GC),

the paracortical area (PA) the medullary cords (MC) and the lymphatic vessels (LV). To note the distribution of B cells

(B220, magenta) and periarteriolar Nes-GFPhigh cells (green).
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Potential solution

Ensure to inject the antibody solution into the lateral tail vein (before you begin step 1c).

Ensure proper perfusion (before you begin step 2b) and fixation (before you begin step 4).

Figure 13. Highly intact tissue architecture and preservation of molecular integrity

(A) Representative 3D reconstructed images showing vasculature (red) in tibial epiphysis/metaphysis and diaphysis.

(B) Representative confocal BM images showing in situ single polar (1) and apolar cell (2) for the epigenetic marker

H4K16ac (green).

(C) In situ subcellular Ki-67 BM cell staining with endogenous HSC 4 days after 5-FU treatment. Arrows indicate Ki-67+

HSC. To note the dilated sinusoidal vessels after the chemotherapy with 5-FU.

(D) Representative extended focus projection of femoral BM from recipient mouse transplanted with RFP+ HSCs.

Donor-derived RFP+ HSCs are marked by yellow arrowheads. Lineage markers, CD41 and CD48, are shown in white,

CD150 in green and endothelial cells are in blue. All donor-derived cells are RFP+ (red).

(E) 3D reconstructed confocal images of a whole-mounted femur from recipient mouse transplanted with CFP+ young

and YFP+ aged HSCs showing donor-derived CFP+ and YFP+ BM cells 6 weeks after transplantation. Hematopoietic

markers (CD41, CD48 and lineage) and FABP4+ in blue.

(F) Whole-mount confocal images revealing periarteriolar Nes-GFPhigh cells (bright green) and overlap of perisinu-

soidal LepR+ cells (magenta) and Nes-GFPlow cells (dim green) in BM of Nes-GFP mice. Dashed lines denote the

endosteum.
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Problem 2

No fluorescence signal detection in big BM areas or holes in BM. Confocal microscopy.

Potential solution

This problem could be due to loss of BM parts and due to uneven positioning of the sample. Also,

nonspecific tissue between the shaved tissue surface and the microscope glass or non-planar cryo-

stat shaving of the sample can cause these problems.

Ensure proper perfusion (before you begin step 2b) and fixation (before you begin step 4).

Remove non-specific tissue between the shaved tissue surface and the microscope glass (before you

begin step 3b).

Shift the blade to an undamaged part or use a new one during cryostat shaving (steps 7 and 8).

Figure 14. Preservation of structure and antigenicity even after long-term storage

(A) 3D confocal whole-mount images of a 3-year-stored (�80�C) long bone processed by iFAST3D showing the

preservation of the antigenicity for the highly sensitive CD150 protein and CD41/CD48/LIN (gray), and intravital

stained vasculature (red).

(B) Representative extended focus projection of the BM of freshly prepared and 5 years stored (�80�C) H2B-GFP

mouse bones processed by iFAST3D showing the proliferation marker Ki-67 (red). H2B-GFP (green).
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Avoid touching the exposed BM (step 11).

Ensure that the sample is placed evenly on the microscope glass (step 24).

Problem 3

Low fluorescence signal. Confocal microscopy.

Potential solution

This issue could have several causes: low concentration of primary or secondary antibodies and

insufficient antibody incubation times.

Optimize the antibody concentrations and incubation times, especially for novel antibodies, or use

fresh ones (steps 16, 18, and 20).

Increase the setting of the laser or/and the detector (laser power, gain) (step 31).

Problem 4

High fluorescence signal or high background staining. Confocal microscopy.

Potential solution

High concentrations of primary or secondary antibodies and too long antibody incubation times

could cause these problems.

Optimize the antibody concentrations and incubation times especially for novel antibodies (steps

16, 18, and 20).

Use a negative control with only the secondary antibody (without the primary antibody) to detect

unspecific binding and optimize the concentration of the secondary antibody (steps 16 and 18).

Decrease the setting of the laser or/and the detector (laser power, gain) (step 31).

Extend the antibody washing times or add some surfactant (e.g., Triton X-100, Tween 20) to the

washing buffer (steps 17 and 19).

Problem 5

Formation of air bubbles between the sample and the bottom glass. Confocal microscopy.

Potential solution

Carefully lift the sample and replace it cut-face down onto the drop in the 4-well-m-slide (Figures 7B

and 7C) and check again from the bottom side that the exposed surface is completely touching the

glass planar (Figure 7D) (step 24).

RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact, Mehmet Saçma, mehmet.sacma@uni-ulm.de.

Materials availability

This study did not generate any new reagents.

Data and code availability

This study did not generate any dataset or code.
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Supplemental information can be found online at https://doi.org/10.1016/j.xpro.2022.101483.
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